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Step 1 - Get Info
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Visual FoxPro Conversion - Step 1 - Get Info

This document explains the process of importing a Visual FoxPro project into FmPro Migrator. Once the
metadata has been imported into FmPro Migrator, the Visual FoxPro project can then be converted into
any of the database development environments supported by FmPro Migrator.

The Visual FoxPro DBF file data can also be converted into a wide range of databases including:
Microsoft Access, DB2, FileMaker Pro, FrontBase, MySQL, OpenBase, Oracle, PostgreSQL, SQLite,
SQL Server or Sybase.

Document Version 7

Updated for FmPro Migrator Developer Edition 5.97
Updated with Visual FoxPro Menu Converter Info
Updated with Visual FoxPro Code Converter Info
1/12/2011

Pre-Migration Tasks

Before starting the Visual FoxPro Conversion process:

1) Add any Free Tables in the Visual FoxPro project to a new or existing database file.

The VFPExport utility only exports table info from DBC files, in order to reduce the change of duplicate
table names being overwritten during the dat transfer process. If the project contains duplicate table
names within separate DBC files, one version of a duplicated table name should be renamed in order to
insure uniqueness during the SQL database transfer process. All tables will be created within the same
SQL database of a SQL database server, so duplicate tables would get dropped and overwritten.

2) If the Visual FoxPro solution contains only Free Tables, then this means that there won't be any
relationships available for exporting. If you want relationships to be exported and used in the new
solution, you will need to add all of the Free Tables into a DBC file and also create relationships
between the tables within the DBC. This process will insure that the VFPExport utility will be able to find
and export the relationships between the tables. Even if the data is already located within a SQL
database server it can be useful to create relationships in the DBC file for use by FmPro Migrator
during the Forms conversion process.
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Select Output Directory, Source Database Type

. FmPro Migrator

¥

3

Get Info

| Drag & Drop @l

Access

FilehMaker 5
FilehMaker B
FileMaker 7
Filehaker 8
FilehMaker 9
FileMaker 10
FilehMaker 11
SOL Server

Visual FoxPro

Launch FmPro Migrator, (1) click on the FileMaker tab, select the Output Director, (3) select Visual
FoxPro from the Source Database menu.

The Output Directory will be used by FmPro Migrator to store the FmPro Migrator MigrationProcess.db3
project file, as well as files generated during the conversion process. It is not recommended that the
Visual FoxPro project directory be used as the FmPro Migrator Output Directory. You will have the
opportunity to select the Visual FoxPro project directory later in the conversion process.
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Select Destination Database

g FmPro Migrator

| About_| FieMaker

tgz'
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Visual FoxPro @ —
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|
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(1) Select the destination database, enter the connection information for the destination database, (2)
ODBC DSN, (3) hostname, (4) port, (5) database name, (6) login username/schema, (7) login
password.
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Export the VFPExport.exe Utility

3? FmPro Migrator

Export QuicKeys or Windutomation Scripts

Export YFPE =port.exe Ltility

Display Tips Ctrl+T
Continue Migration...

Create Project File...

Status Window

Quit Ctrl+0Q

| Drag & Drop @l

Visual FoxPro v
SOL Server @ ODBC DSN.

FmPro Migrator uses the included VFPEXxport.exe utility to export metadata from Visual FoxPro .PGX
project files. Select File -> Export VFPExport.exe Utility from the File menu. The VFPExport.exe utility
is a compiled Visual FoxPro executable which reads and exports the metadata from a Visual FoxPro
.PGXfile. The resulting exported data is stored within the VFPExport.DBF database file.

The VFPEXxport utility will be saved into the FmPro Migrator Output Directory.
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VFPExport Utility - Static MetaData Export Process

o VFPExport E] @
Visual FoxPro Export Utility

www. FrProMigrator.com

== This utility exports project info from a g
selected Visual FoxPro Project File and / ~
' : / saves project metadata into a file named _
VVFPExport.DBF within the same directory \J
Solution.PJX VFPExport.DBF

[ selectproject | [ C/\DSWFP_TESTS\SOLUTIONISOLUTION.PJX |
Project Exported but one or more files has an error

FmPro Migrator uses a 2 step process to import the metadata from within Visual FoxPro projects. Thru
the use of the included VFPEXxport.exe Utility, Visual FoxPro project metadata is read directly from the
VCX, SCX, FRX, DBC, DBF, MNX and PRG files referenced within the .PJX project file. This
information is written into a new database file named VFPExport.DBF.

Launch the VFPExport.exe Utility

of VFPExport

Visual FoxPro Export Utility

I j www, FrProMigrator.com

This utility exports project info from a
selected Visual FoxPro Project File and
saves project metadata into a file named
VFPExport.DBF within the same directory

Q [ Select Project ] ’ CADSWFP_TESTSVSOLUTIONSOLUTION PJX ‘

= O |

Launch the VFPExport.exe utility, (1) Select the Visual FoxPro project file for the project to be
converted, (2) click the Export button.
(3) Any errors which were logged during the export process, will be listed in the errors.txt file which will

Project Exported but one or more files has an error
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be written into the directory where the VFPEXxport.exe utility is located.

Close the VFPEXxport.exe utility.

VFPExport Error Log File

2 errors.txt - Notepad
File Edit Format View Help

Project File : C:N\DS\WFP_TESTS\SOLUTIONYSOLUTION. PJX A
File : C:NDS\VFP_TESTS\SOLUTION\..\cClasses\samples.vcx 3
Error Message: File 'c:ihdsi\wip_testsi\classesi\samples.vcx' does not exist.
Line:

File : C:N\NDSWNVWFP_TESTS\SOLUTIONY..NcTlassesh\buttons.wvcx

Error Message: File 'c:ihdsi\wip_testsihclasseshbuttons.vcx' does not exist.
Line:

File : CINDS\VWFP_TESTS\SOLUTION\..\Classes\utility.vcx

Error Message: File 'c:ihdshwfp_testshclasseshutility.vex' does not exist.
Line:

File : C:\DS\VFP_TESTS\SOLUTIONY. . \data\testdata.dbc

Error Message: File Not Found

Line:

File : C:NDS\VFP_TESTS\SOLUTION\. . \Classes\dragmove. cur

Error Message: File Mot Found

Line:

File : C:NDS\VFP_TESTS\SOLUTION\..\cClasses\nodropOl. cur

Error Message: File Not Found

Line:

File : C:\DS\VFP_TESTS\SOLUTION\..\Classes\clock.bmp

Error Message: File Not Found

Line:

File : C:NDSN\VFP_TESTS\SOLUTIONY..Y\Classes\help.bmp

Error Message: File Mot Found

Line:

File : C:NDS\VFP_TESTS\SOLUTION\..\Classes\moverhox.bmp

Error Message: File Not Found

Line:

File : C:\DS\VFP_TESTS\SOLUTION\..\Classes \watch.bmp

Error Message: File Mot Found

Line:

File : C:NDSA\VFP_TESTS\SOLUTIONY..N\Classes\help.msk

Error Message: File Not Found

Line:

File : C:NDS\VFP_TESTS\SOLUTIONY..\Classes\smmail.bmp

Error Message: File Not Found

Line:

Clicking the error log link will open the error log text file. A common source of errors is missing files
which are listed in the .PJX file but which have been moved or deleted from the project directory.
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VFPExport Utility - Runtime MetaData Export Process

ExportHook Timer Event

VFPEXxport.exe

)\ 74

-

VFPExport.DBF

Since most Visual FoxPro projects contain VCX forms and objects having properties set only at
runtime, an additional AppHook export process is also used to export project metadata. The
VFPEXxport.exe utility is added to the startup code of the Visual FoxPro application. The Visual FoxPro
project is compiled and then run as a user would use the application to open and close all of the forms
within the application. One second after each form is instantiated, the ExportHook timer event fires and
captures metadata for all of the objects on the current form/report. Once the Visual FoxPro application
is closed, the new data is merged with the existing form/report data within the VFPExport.DBF file. By
capturing this information during runtime, all inherited object properties will have been set by the
application code, thus insuring that an accurate representation of the objects has been exported. After
the capture process has been completed, the records within the VFPExport.DBF table can be modified
or even deleted in order to remove obsolete or unused form records.

Note: When FmPro Migrator reads the records within the VFPEXxport table, it first starts by looking for
each of the form and report records. Then it looks for all of the objects associated with the form or
report which is being processed.
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Adding ExportHook to Visual FoxPro Project

B Project Manager - Assets_fox_proje

all || Data | Documents | Classes Other |
-] Programs A
] assets_fox_proje_app .
] setobyf Add...
[€] 4Pl Libraries
=93 Applications Modify
R pexport
Run
Remove...
v Build...

Description:
Path: c:\ds\vip_tests\vfpexport.exe

1) In the Visual FoxPro project it is necessary to set a reference to the VFPEXxport.exe executable file.
This is done in the Code -> Applications tab of the Project Manager.

2) Add the following code to the project's Startup (main PRG or startup form's Init / Load method) code.
Replace the pathname to the VFPEXxport.exe app with the actual path to the executable on your
computer. Also, replace the path to the VFPExport.DBF file with the actual path to this database file,
usually located at the top-level of your project within the directory which contains your project .PJX file.

PUBLIC oFormHook
oFormHook = NEWOBJECT("ExportHook", "bzAppHook.VCX", "C:\Project\VFPExport.exe",
"C:\Proiect\VFPExport.dbf”)
Try
Do StartApplication
Catch (...)

Finally
Release oFormHook
End

3) Build and run the Visual FoxPro project normally.

4) Open each of the forms in your Visual FoxPro application, just as a user would use your application.
During runtime, the ExportHook event will fire and automatically store the properties of every object on
each new form which is opened.
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5) When the VisualFoxPro application closes and the ExportHook is released, the VFPEXxport.exe utility
will merge the captured data with data already extracted by previous run of the utility.

Usage Notes:

1] If the VFPExport.dbf file is found in the root directory of target application, it is opened and

for every form captured, the corresponding record is searched within the VFPExport.DBF file.

If the form was found, the properties are updated with the properties gathered at runtime.

2) If the form was not found, then a new record is created and captured data is saved into the
VFPExport.DBF file.

3) This process works for both stand-alone SCX forms as well as VCX forms defined within libraries.
4) If the VFPExport.DBF file is not found, the captured data is exported to a different file named
VEPEXxport_extra.DBF.

5) If any error occurs during the properties merging process, the captured data is exported into the
VEPExport_extra.DBF file.

Since it is possible that the VFPExport.DBF file might not be found during runtime, it is recommended
that a small sample of forms be tested in order to verify that the data is getting written into the
VFPExport.DBF file. FmPro Migrator is only looking for the VFPExport.DBF file during its processing,
and does not automatically merge data in from the VFPExport_extra.DBF file. This is because the
VFPEXxport_extra.DBF file doesn't contain all of the metadata for the entire project, and FmPro Migrator
may not be able to predict where the VFPExport_extra.DBF file is located on disk.

The Visual FoxPro developer can manually copy the records from the VFPExport_extra.DBF file into
the original VFPExport.DBF file - but it will be easier to just make sure that the process is working
properly to avoid performing this extra manual processing step.
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VFPExport.DBF/FPT Files

& C:\ds\VFP_Tests\Solution @@@

>»

File Edit View Favorites Tools He j','

e Back v (_J l” /..— ) Search

>»

Address

) C:\ds\YFP_Tests\Solution v Go

| LE,

|

L1111
111

|11

EN

43 KB A

VYFPExport.DEF
DEF File
1,796 KB

VFPExport.FPT
Microsoft Yisual FoxPro Table
1,194 KB

volume01.ico

2D e 2
o A

ICO File

<

xref,cdx
Microsoft Yisual FoxPro Index
4 KB

xref.dbf
DEBF File

As a result of running the VFPEXxp

3KB

ort.exe utility, the VFPExport.DBF/FPT files will be found within the

Visual FoxPro project's directory. These files provide the Visual FoxPro project metadata which will be

used by FmPro Migrator for the re

maining steps of the conversion process.

A Note for Experienced Developers

If you want to have more control o

ver the final conversion process, you can edit the contents of the

VFPExport.DBF/FPT files prior to continuing the conversion process. All of the metadata for the Visual

FoxPro project is contained within

these two files. For instance, if you wanted to standardize the names

of the fonts used in your project, you could edit the contents of the properties column of the DBF table
to accomplish this task. Any changes to the VFPExport.DBF/FPT contents must be done at this point in
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the processing, because the very next step of the processing will copy the contents of the
VFPExport.DBF/FPT files into a new VFPExport.db3 SQLite database file. The SQLite version of the
data will be used by FmPro Migrator for the conversion processing.

Step 1 Get Info Button - Drag & Drop Visual FoxPro Project Directory

& C:\ds\WFP_Tests |~ ||[O|[X &?:FumMigrator
Fle Edt View Favor 2| N

Qo - © - @‘ d™

Address |3 Chdsivrp_ v | (£ Go Step 1
. \
| L
\
3

Get Info

= Drag & Drop @
- atz Visual FoxPro
Solution

]

3333

Juserl | DIz

Drag & Drop the Visual FoxPro project directory onto the FmPro Migrator Step 1 Get Info button.
FmPro Migrator will look for the VFPExport.DBF file at the top-level of the Visual FoxPro project
directory. When the VFPExport.DBF file has been located, FmPro Migrator will copy the data from the
VFPExport.DBF/FPT files into a new SQLite database file named VFPExport.db3.

During the conversion process, FmPro Migrator will open the console window 3 times as it is
processing the files.
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Visual FoxPro Tables List

v)? Migration Process

Relationships TOs Yalue Lists CFs Layouts Scripts GUI

T Hmwl

Original Table New Table Destination

Step 1:

Select Exponrt
VFPExport.exe Utility
from the File menu.
The VFPExport.exe
utility will be written
into the output
directory.

dvds
genres
ids
tahlenni
|

Original Fieldname PK |Auto-Increment [Next SN New Fieldname
id 0o |0

price 0 0

listprice 0

Step 2:

Launch the
YFPExport.exe utility,
select the Visual
FoxPro project (PJX)
file, click the Export
hutton. The
metadata for the
Visual FoxPro project
will he exported into |
the YFPExport. DBF % }

file. Create Table Transfer Data
Mot Started Mot Started

After the completion of the Step #1 processing, FmPro Migrator will automatically open the Migration
Process window and display the list of Tables/Fields which have been extracted from the Visual FoxPro
project.
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Visual FoxPro Relationships List

DeveloperfAdvanced.

FileMaker Pro users
may manually add
Relationships and

Cascade Create: [ |
Relationship SOL Code:

Cascade Delete: [ ]

o Migration Process Q@@
Tables | Relationships | TOs | Valuelists | CFs | Layouts | Scripts | GUI
g B o =
) - ’ N [~ .
| % SR AENEs S
Instructions: Relationships: B _
Relationships =| Left Table Name Right Table Name Predicate Count |LTi~|
Migration - ‘customer orders 1 0
FileMaker to SOL orders orditems 1 0
Databases: orditems products 1 0
Within FileMaker Pro | customer orders 1 0
7+ export a DDR MR nriars 1 n =
reportifusing - ]
FileMaker Left Table | Right Table
Table: ’ customer v | Table: ’ orders v ‘

Cascade Create: [ ]

Cascade Delete: [ ]

Predicates on this
screen.

Click the Import
Relationships button
to import a DDR ¥ml
file for each
FilemMaker datahase

Predicates: 1

T

Left Table::Field
customer::.cust_id

file, in order to obtain
a complete list of all
Relationships, Tahle
Qccurrences and
File References.
Once this info has

Join Type [Right Table::Field |
= orders::cust_id

heen imported, —
delete duplicate
Table Occurrences.
Select all ofthe
Relationships, then
click the Create SQL

The relationships exported from the Visual FoxPro project are listed under the Relationships tab of the
Migration Process window. Once the tables have been created in the destination database, the SQL
code can be created and run in order to create the relationships in the destination database.
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Step 2 - Create Table
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Visual FoxPro Conversion - Step 2 - Create Table

Step 2 - Create Table

g;)v Migration Process

Relationships TOs Yalue Lists CFs Layouts Scnpts GuUl

Step 1:

Select Export
YFPExport.exe Utility
from the File menu.
The VFPExport.exe
utility will be written
into the output

directary. Original Fieldname PK |Auto-Increment |Next SN New Fieldname
id 0o |0

price 0 |0

listprice 0

Step 2:

Launch the
YFPExport.exe utility,
select the Visual
FoxPro project (PJX)
file, click the Export
hutton. The
metadata for the
Yisual FoxPro project
will be exported into
the VFPExport. DBF

file. Create Table Transfer Data
MNat Started MNat Started

i)

(1) Click on any table, (2) click on the Create Table button.
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Create Table - Troubleshooting

Step 2

Create Table
Mot Started

If errors occur when creating the table, you can examine or change the table creation SQL code by
clicking the Create Table Details button.

You can also change the destination database connection properties on the Step 1 tab in FmPro
Migrator. Then click the Create Table button again.

Double-clicking the name of the table in the list of tables opens the Table Details window, where
changes can be made directly. But it is easier to make database connection changes on the Step 1 tab
since the changes will be made for all of the tables instead of just one individual table.
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Table Creation Details Window

gy?ﬁ Table Creation Details

[Assets).[user).[dvdprice]

CREATE TABLE [Assets].[userl].[dvdprice]

ia
VARCHAR(25) NOT NULL, - — =
price

DECIMAL{18,4) NOT NULL,

listprice

DECIHMAL{18,4) NOT NULL

)
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Duplicate Table Warning Dialog

If the table already exists in the destination database, the duplicate table error dialog will be displayed.
Hold down the shift key when clicking on the Create Table button in order to drop and recreate the
table.

Note: Dropping the table will cause the loss of all data in the table.
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Step 3 - Transfer Data
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Visual FoxPro Conversion - Step 3 - Transfer Data

Step 3 - Transfer Data

23? Migration Process

Relationships

Step 1: @
Select Export
VFPExport.exe Utility
from the File menu.

The VFPExport.exe

utility will be written  —

into the output
directory.

Step 2:

Launch the
VFPExport.exe utility,
select the Visual
FoxPro project (PJX)
file, click the Export
hutton. The
metadata for the
Visual FoxPro project
will he exported into
the VFPExport. DBF
file.

Click the Step 3 button to transfer data from a DBF file into the new table which has been created in the

destination database.

W

Original Table

dvds
genres
ids

TOs Yalue Lists

tahlenn1
)

Original Fieldname
id

price

listprice

CFs Layouts

PK |Auto-Increment
0 0
0 0
0

Create Table
Completed

Scripts

GUI

Next SN
id
price
listprice

Transfer Data
MNat Started
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Troubleshooting - Column Change Buttons

ﬁ Migration Process

Tables | Relationships | TOs | ValueLlists | CFs | Layouts | Scrpts | GUI

ET HEwl

/ Tables: 7
|nstructions: Original Table New Table Source Destination [Fields |[Record =
Step 1:' o - dvdprice dvdprice 1tﬁsual FoxPro |SQL Server |3
Select Export dvds dvds V!sual FoxPro |SQL Server |7
VEPExport.exe Utility genres genres V!sual FoxPro |SQL Server |2
from the File menu. ids ids V!sual FoxPro |SQOL Server |2
The VFPExport.exe 1iahlnnn1 tabhlen Visnal FnkPrn 1ISQI Server 1R 2 o)
utility will he written
into the output Fields: 3
directory. ID Original Fieldname
1 id
Step 2: 2 price
Launch the - 3 listprice
YFPExport.exe utility,
select the Visual
FoxPro project (PJX) i b
file, click the Export
button. The Step 2 Step 3
metadata for the
Visual FoxPro project * :
will he exported into :
the VFPExport. DBF J )
file. Create Table Transfer Data
= Completed Not Started

Sometimes, it is necessary to change the column types for table columns in order to transfer the data
into the destination database. For instance, due to data entry errors or unvalidated data - a Date or
Numeric column may need to converted into a text column. This would be done just for the purpose of
transferring the data as text into the destination database. Then stored procedures or SQL code could
be written to fix problems with the entered data.
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Troubleshooting - Table Details Window

g Table Details

sqlserver_dsn

The Table Details window can be displayed by double-clicking on a table in the list of tables. Clicking a
different table with the Table Details window displayed will automatically update the info in the Table
Details window with the info for the table which has been clicked.
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Troubleshooting - NOT NULL Column

Sometimes it is necessary to change column properties like the NULL/NOT NULL status. The Visual
FoxPro dvds.dbf file within the example Solution includes columns set for NOT NULL, but the tables
actually contain NULL values - thus causing an error during the data transfer step. Column properties
can be changed via the Field Details window.
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Troubleshooting - Field Details Window

o Field Details M(=1E3

TEXT v

T

NOTNULL &

NULL
NOT NULL

lobal_Status_Men +

Double-clicking on a column for the database table opens the Field Details window.

After making changes to column properties, hold down the shift key then click the Create Table button
in order to drop and recreate the table. Then click the Transfer Data button again.
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Report Export Buttons

o Migration Process Q@@

Tables | Relationships | TOs | Valuelists | CFs | Layouts | Scrip

3 =T =

l . Tables: 7 -
Instructions: Original Table New Table Source Destination  [Fields [Record =
Step 1 - | dvdprice dvdprice Visual FoxPro |SQL Server (3

Pt dvds dvds Visual FoxPro [SQL Server |7
Select Export -
VFPExport.exe Utility genres genres Yisual FoxPro |SQL Server |2
from thpe Fi'le i ids ids Visual FoxPro |SQL Server |2
The VFPExpor’(.e}{e. .'r‘ahlenm tahlenni Visnal FnxPrn 1SQI Server 1R . o=
utility will he written o 193 Varchar
into the output Fields 7 ) v v
directory. ID Original Fieldname PK |Auto-Increment |[Next SN New Fieldname =

_ 1 id 0 0 id
Step 2: 2 hame o o hame
Launch the . 3 listprice 0 0 listprice
VFPExport.exe utility, 4 duedate o o duedate
selectthe "‘fflsual A nenrein n n nenrein o=
FoxPro project (PJX) i 4
file, click the Export
button. The Step 2 Step 3
metadata for the
Visual FoxPro project * - :
will be exported into
the YFPExport.DBF ! ,
file. Create Table Transfer Data
S Completed Completed

The XLS report button exports a summary .XLS spreadsheet to the output directory containing the table
names and completion status for each of the tables in the list.
Note: The completion status below the Step 2/Step 3 buttons is a pop-up menu which can be changed

manually. Therefore if you want to mark a status as N/A then this can easily be done for any of the DBF
tables.

The 2nd report button, creates a detailed table summary report for the currently selected table. This
plain text file includes info about the column types/sizes and is also written into the output directory.
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Import MetaData
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Visual FoxPro Conversion - Import MetaData

GUI Tab - Visual FoxPro Conversion Service Button

=

Instructions:

Tables

Convert Layouts
to HTML:

Click the Convert
Layouts to HTML
hutton to convert
each FileMaker Pro
layout into an HTML
file. Each file
includes fields, text
labels, images,
graphic ohjects and
JavaScript code for
implementing
portals and pop-up
calendar pickers.

Export Layout XML:
Click the Expont
Layouts as XML
hutton to export the
layout definition XML
for all layouts as text
files. Each layout is
exported as a text file
within a folder
named
Layout_xML_Files
within the output
directory.

Access to FmPro

o Migration Process

Relationships TOs

Convert Layouts
to HTML

Yalue Lists CFs

Export Layouts
as XML

|

Access to FmPro
Migration Service

LiveCode
Conversion

Layouts

Scripts | GUI | o

Services

FmPro to Access
Migration Service

-~

5

PHP to LiveCode |
" Conversion

-
”~ ;J% .
A A

Servoy
Migration Service

» sC
Ng

Visual FoxPro
Conversion Service

(1) Click the GUI tab on the Migration Process window, (2) click the Visual FoxPro Conversion Service

button.
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Visual FoxPro Conversion Service Window - Features

® Visual FoxPro Conversion Service
£ M »
NA

Instructions:

Import Visual
FoxPro Files:

Step 1) Select Visual
FoxPro as the
source databhase on
the main FmPro
Migrator window. VFP Directory:

Form/Report Oty:

Step 2) Drag & Drop Processing Type: Demo
the Visual FoxPro

directory onto the
Drag & Drop icon.

Step 3) Select the
VP Migration
Service button on the
GUI tah.

Step 4) Verify that the

VFP directory field QUOTE
contains the

pathname to the

folder containing the

Visual FoxPro files.

(1) Select the Visual FoxPro project directory, (2) click the Refresh button to update the list of
Forms/Reports in the Visual FoxPro project. (3) Use Demo mode or order a License Key for the
guantity of Forms/Reports which need to be processed.

To enter the Visual FoxPro license key, select "Licensed" from the Processing Type menu, copy the
license key to the clipboard from your email program, click on the clipboard icon to the left of the license
key field. The license key will be copied from the clipboard and validated.

(4) Click the Import button to convert and import and the Visual FoxPro project metadata into FmPro
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Migrator.

Note: Without a Visual FoxPro Conversion license key, up to 5 Forms/Reports will be converted in
Demo mode.

Visual FoxPro Conversion Service Window - Refresh Button

23?‘ Visual FoxPro Conversion Service

Import Visual
FoxPro Files:

Step 1) Select Visual
FoxPro as the
source database on
the main FmPro
Migrator window:. =Clory .

Step 2) Drag & Drop st i

the Visual FoxPro
directory onto the
Drag & Drop icon.

¥ig=

Step 3) Select the
VFP Migration
Service button on the
GUIl tah.

D00 08 00000090 A PR D00 08 DR 10M0 0P8 AN 8

Step 4) Verify that the
VFP directory field
contains the
pathname to the
folder containing the
Visual FoxPro files.

AL LR ALY AR

1

LS -HA.AJ‘.._- il RN

After selecting the Visual FoxPro project directory, clicking the Refresh button reads the number of
Forms/Reports from the VFPExport.db3 SQLite database and displays the info on the Visual FoxPro
Conversion window.
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Visual FoxPro Conversion Service Window - Import Button

ﬁ Visual FoxPro Conversion Service
.
| 3’ Ny W

Instructions:

Import Visual
FoxPro Files:
Step 1) Select Visual
FoxPro as the

source database on Form/Report Qty: a7 | Refresh

the main FmPro _
Migrator window. YFP Directory: C:/dsAVFP_Tests/Solution Browse

Step 2) Drag & Drop Processing Type: Licensed v

the Visual FoxPro
directory onto the

Drag & Drop icon. —
VYalid License Key

Step 3) Select the Valid Until 1171272011 (87 Forms/Reports)
VFP Migration
Service button on the
GUIl tab.

License Key: ‘

Step 4) Verify that the

VFP directory field QUOTE
contains the

pathname to the

folder containing the

Visual FoxPro files.

(1) Clicking the Import button will start the processing of the Forms/Reports and their enclosed objects.
FmPro Migrator converts each Form/Report and enclosed objects into the Layout XML format which is
used to store the information within FmPro Migrator. Any comboBox static values which are found on
the Forms will be converted into Value Lists. And any FoxPro code embedded within Form/Report
objects will also be imported into FmPro Migrator as well as being written into the VFP_Scripts.txt file
within the FmPro Migrator Output Directory.
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Visual FoxPro Conversion Results - Value Lists

g)v Migration Process

" Tables | Relationships | TOs | Valuelists | CFs Layouts | Scripts | GUI

Value Lists ~ | Value List Name
Migration: Checkbox 1/0

[Used for FileMaker Value List 1
Table Consaolidation Value List10
Migration Projects !

and to FileMaker Ml
Migration Projects.)

Value Lists are

imported Apples
automatically when g'anges

. ananas
reading an exported Peaches
DDR onthe Kiwis
Relationships tah.
Static Value Lists are
migrated to the new
FileMaker Pro
database.

< |

During Access to
FileMaker migration
projects, the Value
Lists are read from
the Access DDR Text
file. This feature is
available from the
Accessto FmPro
Migration Service
hutton on the GUI tah.

Static lists of values from comboBox objects will be converted into Value Lists. Clicking on a Value List
displays its contents as a list of text values.
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Visual FoxPro Conversion Results - Layouts & Portals

o Migration Process g@@

Tables Relationships TOs Walue Lists CFs Layouts Scripts GUI
s

—_— -—-_—-.‘:Ll i_ o < e ——
l " :::‘ = ‘ = . i ’ - |
Instructions: Layouts: 87  dvnarid Table: products v Passi
_ I | QUL nun, 39U u u =
[LJ:g;"fx"%';;';’" ddrop 490,320 0 0
consalidation dsession 749273 4 0
N dyngrid 558,498 13 1
Access to FileMaker :
. edithox 519,498 4 0
Pro and FileMaker dllmenu 536,382 3 0
Layout to HTML, ' =
Servoy, and Access
migration projects ] Portals: Portall
Within FileMaker Portal Name Fill Method Field Titles
7181810 {layout Portall On Record Advance

mode), select all
ohjects on a layout
then select Copy
from the Edit menu.
Click the Add Layout 1
hutton on this screen Layout Image
to copy the layout
definition from the
cliphoard into FmPro
Migrator. Each layout
can be copied
individually in this Paortall
mannet, or all
layouts can he
imported in hatch
mode (see info
helow). Each layout
is given a default
name in the form:
Layoutet where ¢ is
anincrementing

i

-

-

B

Forms and Reports are converted into Layouts, visible under the Layouts tab. The selected Layout
shown in this screenshot shows a portal, which was created from the Visual FoxPro Grid object.
Clicking on the portal shows is size and position within the rectangle of the Layout Image. The exact
contents of the Layout will be visible once the Layouts have been converted into the destination
database/development environment.
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Visual FoxPro Conversion Results - Scripts

Migrator. All scripts
within a FileMaker
file can he copied all
at once, each script
will retain its name
as displayed within
Scripttaker.

During Access to
FileMaker Pro
migration projects,
the Visual Basic
code is read from
the Access DDR Text
file, converted into
FileMaker Scripts
and displayed on
this tah. This feature
is availahle from the
Access to FmPro

# PROCEDURE drawaction
# Parameters nMPointer
# #define INACTIVE_LOC " - (Inactive - "
# #define ACTIVE_LOC " - (Active - "
#Z * Change mouse pointer and form caption as needed
=
if "MPointer=1
THISFORM.mousepointer= 2
else
THISFORM.MousePainter=1
endif

INACTIVE_LOC ACTIVE_LOC)

THISFORM.SetCaption
THISFORM.refresh

z

z

z

z

z

#

# THISFORM.cFormMode = iifinMPointer= 2, ;
=

# ENDPROC

i

o Migration Process @@@
| Tables | Relationships | TOs | Valuelists | CFs | Layouts ‘ Scripts ‘ GUI
& = ——
‘ / - = v ‘,/ y
Instructions: Scripts: 131
ScriptMaker Script = ;;;;‘;;;gf’;{n é;:{ 1
Mlgmtlm_l: Form_ddrap 478
Copy sctipts from Form_dsession 805
FileMaker Pro 9 or Forrm_dyngrid 1513
FileMaker Advanced Form_editbox 772
onto the cliphoard, - =
from within
Filemaker. Click the Script Text:
Add Scripts button - J— Form: dsession =
onthis screentoadd — fa_ File: CADSWFP_TESTSISOLUTIONWc\dsession.scx
the scripts to FmPro H o Obiject: frmfd

Clicking the Scripts tab of the Migration Process window displays the source code which has been
exported from the Visual FoxPro project. Visual FoxPro code for each Form/Report object is exported
and grouped together with code from all of the other objects on the same Form/Report. Clicking a script

displays its contents.

Source code from PRG files is also displayed in the list of scripts, with one script representing each

.PRG file.
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Conversion Process - Next Steps

At this point in the conversion process, the metadata from the Visual FoxPro project has been imported
into FmPro Migrator and stored within the FmPro Migrator MigrationProcess.db3 database file using a
standardized format. This internal storage format makes is possible to perform conversions into any of
the formats supported by FmPro Migrator. It is a matter of selecting the desired conversion target
database/development environment and generating the files.

License Key Note: The Visual FoxPro Conversion license key used during the Visual FoxPro import
process, can also be used to unlock all of the other conversion targets on the GUI tab of the Migration
Process window, in order to complete the conversion process.
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Visual FoxPro .MPR Menu
conversion
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Visual FoxPro Menu Converter - Servoy

FmPro Migrator Developer Edition includes the MacOS X and Windows versions of the Visual FoxPro
Menu Converter as a compiled stand-alone application. This application converts FoxPro generated
menu .MPR files into Servoy JavaScript code.

Visual FoxPro Menu Converter 1.10
1/1/2011

Introduction

The Visual FoxPro Menu Converter included with FmPro Migrator Developer Edition reads the
GENMENU code from FoxPro .MPR files and converts the code into Servoy JavaScript code. Menus
can be converted individually, as shown in the demo below, or can be converted for an entire Visual
FoxPro project all at once. The Conversion Type menu provides two conversion options. Visual FoxPro
menu STYLE parameters for menu items are converted into embedded HTML tags, supporting the
style options: Bold, Italic, Underline, and Strikeout.

ON SELECTION statement procedure calls are converted into empty Servoy JavaScript functions to
enable quick testing of the generated menu code.
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Production Conversion Tab

“a= Visual FoxPro Menu Converter
File Edt Help

,_‘ Visual FoxPro Menu Converter 1.10

ﬁ enu www.FrnProdigrator.com
Item1

Item2

| _ltem3 This utility converts Visual FoxPro .MPR files for
use with other development environments.

Production \ Development

VFP Directory: [ C./dsVFP_Tests/Solution } [ Browse ] Q

Conversion Type: | Servoy Pop-Up Menu JavaScript ‘ @
Output Directory: [ C:/ds/VFP_Tests/Solution_VFP_Fmig/ ] @

7 Menus Processed in 47 ms.

Coe ]

The Production tab will read all of the Menu records from the VFPExport.db3 SQLite database file
which was created at Step 1 of the conversion process. To perform a production conversion, (1) select
the Visual FoxPro project folder containing the VFPExport.db3 file, (2) select the type of JavaScript
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menu code to generate, (3) select the output directory where the generated JavaScript file will be
written, (4) click the Convert button.

Development Conversion Tab

“a Visual FoxPro Menu Converter
File Edit Help

Visual FoxPro Menu Converter 1.10

winw. FmProMigrator.com

This utility converts Visual FoxPro .MPR files for
use with other development environments.

M‘ Development | ,
l Clear Source Code ]o

Visual FoxPro Menu Source Code:

DEFINE MENU example BARAT LINE 1 »
DEFINE PAD convpad OF example PROMPT “<Conversions' COLOR SCHEME 3;

KEY ALT+C, " —
DEFINE PAD cardpad OF example PROMPT ‘Card “Info' COLOR SCHEME 3;

KEY ALT+."

0N PAD convpad OF example ACTIVATE POPUP conversion

0N PAD cardpad OF example ACTIVATE POPUP cardinfo

DEFINE POPUP conversion MARGIN RELATIVE COLOR SCHEME 4 M

Conversion Type: Servoy App Menu JavaScript v J @ < 3 ’

Output Code:

function menul_example_convpad_apm() ~

var appMenu = plugins. window. gett enu(plugins. window. getMenuCount() - 1);

var menul = appMenu.addMenu('Conversions', null, null, 'c');

var submenul = menul.addMenultem(‘area’, null, null, 'e');

var submenu2 = menul. addMenultem('Length’, null, null, ';

var submenu3 = menul. addMenultem('Mass', cmdblue_click , null, 's'); // _screen. activeform.otoolbar.cmdBlue.cl
var submenud = menul. addMenultem(”, cmdwhite_click , null); /¢ _screen. activeform.otoolbar.cmdwhite. click

}
function menul_example_cardpad_apm()

var appMenu = plugins. window. getMenu(pluains. window. getMenuCount(] - 1);

var menul = appMenu.addMenu('Card Infa’, null, null, 'i);

var submenul = menul. addMenultem(iew Charges’, cmdred_click , null, 'v'); // _screen. activeform.atoolbar. cr
var submenu2 = menul. addMenultem('<html> <b><i><u>View Payments</b> < /i> </ur < html>', cmdgreen_click , t
var submenu3 = menul. addMenultem(*iew Users', null, null, 'w");

var submenud = menul. addSeparator();

var submenub = menul. addMenultem('<html><b><i><u>Charges </b></i></u> < html>', null, null, 'c");

var submenub = menul.addSeparator();

var submenu? = menul.addMenultem(‘Exit ', null, 'media:/#/lmagel.bmp’, '2);

< | >

The development conversion tab is designed to provide a place where a single menu script can be
quickly pasted and converted, making it easy to observe the differences between the App Menu and
PopUp Menu JavaScript generated code output.
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(1) Click the Clear Source Code button to clear the contents of the Visual FoxPro Menu Source Code
field. Copy menu source code from any of your Visual FoxPro .MPR files, and paste into the Source
Menu field. (2) Select the type of JavaScript menu code to generate, (3) click the Convert button. The
code will be converted and the contents of the Output Code field will be copied and put onto the
clipboard - ready for pasting into the Servoy Eclipse IDE.

Servoy PopUp Menu JavaScript

CardInfo popup

Card Info
View Charges

View Payments
View Users

Charges

Servoy popup menus are typically attached to form objects, and are useable within SmartClient and
WebClient deployed applications. The generated JavaScript code automatically displays the menu
above/below the clicked object. PopUp menus can also be displayed at specific coordinate locations on
the form canvas, by modifying the generated code.

The generated JavaScript code for Servoy PopUp menus is written into a file named menus_ppm.js
within the output directory for production conversions.

Servoy Application Menu JavaScript

vfp_solution - bldtree - Servoy Client

(2) Help F1 & B 7 U

View Charges

BackColor P View Payments
| View Users

il
|

About...

Charges

A Servoy application menu can only be used within the SmartClient. Each menu appears under the last
menu in the list of menu items. Menu items are displayed as submenu items.

Visual FoxPro to Servoy Conversion Procedure - 42




The generated JavaScript code for Servoy Application menus is written into a file named menus_apm.js
within the output directory for production conversions.
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Visual FoxPro .PRG Code
conversion
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Visual FoxPro Code Converter - Servoy

FmPro Migrator Developer Edition includes the MacOS X and Windows versions of the Visual FoxPro
Code Converter as a compiled stand-alone application. This application converts FoxPro .PRG files
and embedded form object code into Servoy JavaScript code.

Visual FoxPro Code Converter 1.17
1/12/2011

Introduction

The Visual FoxPro Code Converter included with FmPro Migrator Developer Edition reads the imported
code from FoxPro .PRG files and converts the code into Servoy JavaScript code. Code can be
converted individually, as shown using the Development tab, or can be converted for an entire Visual
FoxPro project all at once.
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Production Conversion Tab

#3 Visual FoxPro Code Converter
File Edit Help

Visual FoxPro Code Converter 1.17

winw. FmProhdigrator.com

This utility converts Visual FoxPro source code
for use with other development environments.

Production ‘ Development

Output Directory: | C:/ds/VFP_Tests/Solution_VFP_Fmig/
Conversion Type: { Servoy JavaScript v ]
Q
Statistics:
6 Scripts Processed in 92 ms. »

Total Lines Processed: 1426

% Lines Processed: 94%

Blank Lines Processed: 287

% Blank Lines Processed: 20%

Comment Lines Processed: 245

% Comment Lines Processed: 17%

Unsupported Lines Processed: 141 @
% Unsupported Lines Commented: 9%
UnProcessed Lines: 75

% UnProcessed Lines: 5%

------------ UnProcessed Keywords List -

10 THISFORMSET .frmFD .DrawColor [

9 frmF ormM ame. line[r{Center,0,re{Center,frmF ormM ame. height)

9 frmF ormM ame. line(0,nY Center frmF ormmM ame. width,nv Center)

5 frmFormM ame. line(nOldX+nXCenter,nYCenter-nOldY tempplotz+nxCenter,nY Center-tempploty)
5 frmFormM ame. pset(tempplotx+re{Center,nY Center-tempploty)

4 frmFormM ame. pset(n<Center+[nXT emp*nE quScale),nYCenter-y)

4 frrFormM ame. line[rXCenter+(n0ldX*nE quS cale) nY Center-n0IdY, nXCenter+[nXT emp*nE quScale],nYCenter-nY)
2 thisforline(this. oldx this. oldy this. currents, this. currenty)

2 THISFORMSET.frmFD.SetCaption

2 THISFORMSET .frmFD.ClearForm

2 THISFORMSET.frmFD.ChgDrawhMode

2 THISFORMSET.frmFD.SetPenwidth (

2 THISFORMSET.frmFD.GraphDemao [

2 Main.Show

P THICENRMEET ferFN CatNrzimbdada § !

The Production tab will read and process all of the script records written into the FmPro Migrator
MigrationProcess.db3 project database file during the Visual FoxPro conversion process. To perform a
production conversion, (1) select the FmPro Migrator project folder containing the
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MigrationProcess.db3 file, (2) click the Convert button. (3) The conversion statistics will be displayed
within the Statistics field below the Convert button. The generated Servoy JavaScript files will be written
into a folder named VFP Converted Scripts within the output folder.

Development Conversion Tab

A Visual FoxPro Code Converter Q‘E\@

File Edt Help

Visual FoxPro Code Converter 1.17

wiwwy FrmProMigrator.com

This utility converts Visual FoxPro source code
for use with other development environments.

[ Proguston | Development |

Visual FoxPro Source Code: Q—[ Clear Source Code ]
A~

---------- datepick.prg

---------- CADS\WFP_TESTSASOLUTION reports\datepick.prg
* Plot graph [Polar).

* Parameter:

* 1) cEquation [For radius) in terms of X. TYPE = Character.

* 2] nFrom. Where to stop counting for X. TYPE = Numeric.

* 3] nTo. Where to start counting for X. TYPE = Numeric.

* 4] nSteplnc. Step increment. TYPE = Numeric. v

Conversion Type: Servoy JavaScript VA‘ @

Output Code: Output Code | Statistics

£ eeeeen datepick.prg -~
Feeeenns CADSYWFP_TESTSASOLUTIONreportshdatepick. prg

/¢ Plot araph [Polar). 3
/{/ Parameter:

/¢ 1) cEquation (For radius) in terms of X. TYPE = Character.

/¢ 2] nFroWhere to stop counting for X. TYPE = Numeric.

/¢ 3] nTo. Where to start counting for X. TYPE = Numeric.

/¢ 4] nSteplnc. Step increment. TYPE = Numeric.

/¢ Bl nEquColor. TYPE = Numeric.

/¢ B) IConnect. [f the previous point is connected to the cuumnt point with a line. TYPE = Logical.

/¢ 7] nXCenter. Point on form where x = 0. TYPE = Numeric.

/¢ 8] nYCenter. Point on form where y = 0. TYPE = Numeric.

/¢ 9] ladddCoords. If you should add coordinate lines. TYPE = Logical.

/¢ 10) frmFormMName. MName for form to write on. TYPE = Character.

/# 11)nEquScale. Scale. TYPE = Numeric.

function datepick_prg (cE quation,nFrom,nT o,nSteplnc,nE quColor,IConnect, nixCenter,nY'Center [&ddCoords, frmForm
var noldY;

var n0ldx;

var nTemphaxMNum;

nTempkaxNum = 30000;

if (PARAMETERS()< 10) { v
< >

The development conversion tab is designed to provide a place where a single FoxPro script can be
quickly pasted and converted.

(1) Click the Clear Source Code button to clear the contents of the Visual FoxPro Source Code field.
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Copy source code from any of your Visual FoxPro .PRG files, and (2) paste the code into the Source
Code field. (3) click the Convert button. The code will be converted and the contents of the Output
Code field will be written into the Output Code field and will also be put onto the clipboard - ready for
pasting into the Servoy Eclipse IDE. (5) Clicking the Statistics tab will display the conversion statistics
for the converted script.

Pasting Converted Code into the Servoy Eclipse IDE

assets ¢ globals.js 83 =0
533 } -
534

535=//1// We need to check to make sure the end date selected is
536 //1// after the start date.
@527 if.((nFromYear > nToYear). || .(nFromYear == nloYear &%  nFromMonth > nToMonth) THEN) {
53% var myPressedButton - plugins.dialogs.showInfoDialog(FROM_GREATER_TO_LOC);
539 THISFORcboFromYear.SetFocus;
549 //return;
541 }
542
543=//1// For the end date, we need to figure out the last day of the month Q
=a

544 //1// that was selected.

545 //1// (Note that the one flaw in this CASE statement is that it doesn't
546 //1// take into account leap year.)
547 switch (1) {

54% case nToMonth - 2:

549 nEndDay - 28;

550 break;

551 case INLIST(nToMonth,4,6,9,11):

552 nEndDay - 30;

553 break;

554 default:

555 nEndDay - 31;

556 }

557

558 //1// Finally, we can set up our start and end date public variables
559

560 dStart_Date - DATE(nFromYear,nFromMonth,1);
61 dEnd_Date - DATE(nToYear,nToMonth,nEndDay);
;':,-a THISFORRelease;

64 } // end of: cmdok_Click

65

LT T T T

7 } // end of: frmdatepick

//

//-- EndDefine: frmdatepick m
=

Ki LITLLLTLLLT LTSI LTSI 7777777
571

@573 }.//.end of: datepick..prg

— =) <»

[2 problems §3 . L]ll Bookmarks | 4 Classic Search| <" Search | | Tasks| {5} Profiler View| El Console v =0

4 errors, 21 warnings, 0 others

Description A Resource Path

¥ @ Errors (4 items) m
€3 missing ) after condition globals.js /vipl
€3 syntax error globals.js [vfpl
€3 syntax error globals.js [vfpl

(_..".--'.-‘.'.;-'. ........... —_—) T T

Converted files can be copied and pasted directly into the Servoy Eclipse IDE, or the JavaScript files
can be moved into the project folder for editing. However, this is not necessarily the best way to work
with converted code files due to the structure of the original Visual FoxPro code. Generally, it is
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recommended that the code be pasted and modified in small blocks.

This screenshot shows a 573 line script named datepick.PRG which was converted and pasted into a
new globals.js file within the Servoy project. (1) Note that the converted script is showing 4 errors within
the Problems tab below the script editor window. (2) Also, the red error bars are displayed along the
right hand edge of the editor window. These 4 errors represent a 0.7% error rate for the converted lines
of code. Typically the converted script error rate will be 0% - 3%, and these errors will at least need to
be commented out in order for the Servoy Eclipse IDE to format and parse the code.

Commenting Errors & Formatting Converted Code

[Z] globals.js 23 - O
10//--====-=-=- datepick.prg
2 /)= C:\DS\VFP_TESTS\SOLUTION\reports\datepick.prg m
3 // Plot graph (Polar).

1 // Parameter:

5 // 1) cEquation (For radius) in terms of X. TYPE = Character.

6 // 2) nFro Where to stop counting for X. TYPE = Numeric.

7 // 3) nTo. Where to start counting for X. TYPE = Numeric.

&8 // 4) nStepInc. Step increment. TYPE = Numeric.

9 // 5) nEquColor. TYPE = Numeric.
10 // 6) 1Connect. If the previous point is connected to the cuurnt point with a line. TYPE = Log
11 // 7) nXCenter. Point on form where x = 0. TYPE = Numeric.
12 // 8) nYCenter. Point on form where y = 0. TYPE = Numeric.
13 // 9) 1AddCoords. If you should add coordinate lines. TYPE = Logical.
14 // 10) frmFormName. Name for form to write on. TYPE = Character.
15 // 11) nEquScale. Scale. TYPE = Numeric.
16— function datepick_prg(cEquation, nFrom, nTo, nStepInc, nEquColor, 1Connect, nXCenter, nYCenter,

17 var n0ldY;
18 var n0ldX;
19 var nTempMaxNum;

20 nTempMaxNum - 30009;

22 if (PARAMETERS() < 10) {

23 //#define PGRAPH_LOC "This program requires multiple parameters.”
24 application.sleep(5); //WAIT WINDOW PGRAPH_LOC

25 //return;

26 }

28 if (TYPE('nEquScale') != "N") {
nEquScale - 1;
}

32 if (1AddCoords) {

33 // Add coordinate lines. R=0.

34 frmFormName . forecolor - rgb(@, 9, 9);

35 frmFormName.line(nXCenter, @, nXCenter, frmFormName.height);
36 frmFormName.1line(®, nYCenter, frmFormName.width, nYCenter);

}

ﬁﬁ // Calcuate old values for x,y (n0ldX,n0ldY). Used if connect is True.
10
11 X = nFrom;

€eEe————— =) <>

Making a few changes to the code results in resolving the 4 errors. Selecting Source -> Format formats
the code and applies proper indenting to make the code easier to read. The code can now be tested
with the debugger or edited further.
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In general, comments should be located within the method they reference, instead of being above the
function definition as is commonly done within FoxPro code - or the comments may be removed during
the code formatting process. The converted code has also been changed a little bit from the original in
an attempt to wrap the contents of .PRG code within a function, by adding a function definition in place
of the first PARAMETER statement near the top of the code. A closing curly bracket was also added at
the end of the code as well.

Understanding the Conversion Statistics

The code conversion statistics are designed to provide a general idea of the percentages of processed,
unprocessed and unsupported lines of code which were converted. Here is an explanation for these
statistics:

Total Lines Processed: The total number of lines which were processed.

% Lines Processed: - The percentage of lines for which some type of processing was done. Each line
will either be modified or passed thru unchanged. The following statistics lines provide more details of
what was done during the processing.

Blank Lines # or %: - Blank lines will be counted as processed, because nothing needs to be done to
them even during a manual conversion since white spaces aids code readability.

Comment Lines # or %: - Comment lines are modified by changing the FoxPro comment character
with the JavaScript comment character.

Unsupported Lines # or %: Unsupported Lines are counted in the processed lines percentage,
because the lines have been analyzed and determined to be unusable within the context of a multi-user
server based environment. A detailed listing of the Unsupported Keywords is provided at the end of the
report. These lines are commented to prevent errors.

UnProcessed Lines # or %: The UnProcessed lines are not counted within the total processed
percentage, because they did not match an implemented keyword. Each line is passed thru with a
semicolon added to the end of the line. Lines containing the equality operator are not considered
UnProcessed, and they are also passed thru with a semicolon added to the end of each line.

UnProcessed Keywords List - During script processing, a log is kept of the keywords which were not
processed because they did not match a known FoxPro keyword. The number of times each keyword

was found is logged along with the first two words of the instruction line. This list provides a quick way
to determine if there are FoxPro keywords which need to be added to the conversion process.

UnSupported Keywords List - Each UnSupported Keyword is logged during processing along with a
number indicating how many times it was found during processing. This list can provide a quick way to
review whether there are FoxPro keywords which could potentially be added to the list of supported
keywords in the future. For instance if a particular keyword is observed many times, and a logical
replacement can be for the keyword, then the process can be improved considerably.
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preParse Processing

Prior to the line-by line processing of each line of source code, a preParse processing step is
performed on each script.
The tasks performed at this stage of processing include:

Removal of Line Continuation Characters - The Visual FoxPro line continuation character is a
semicolon, which conflicts with the JavaScript line ending character - therefore it must be removed for
compatibility purposes. Also, concatenating each of the individual lines together into one single new line
makes is easier to parse the original line of code. The total number of lines counted for statistical
purposes represents the number of lines which exist in the source script after removing the line
continuation characters.

Common FoxPro Function Replacement - Some commonly used FoxPro functions, operators and
constants have direct replacements within Servoy JavaScript code. The following replacements are
made across the entire script:

Operator and Constant Replacement
AND => &&

OR = ||

NOT =

<> => =

m. => empty

.T.=>true

.F. => false

tab => empty

Function Replacement
UPPER()=> toUpperCase()
LOWER() => toLowerCase()
LEN() => str.length()

VAL() => parseFloat()

INT() => parselnt()

LTRIM() => stringTrim()
RTRIM() => stringTrim()
ALLTRIM() => stringTrim()
SUBSTR() => str.substr()
CHR() => String.fromCharCode()
ASC() => charCodeAt()
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Manual Code Changes

Statistics: Output Code Slaics
Total Lines Processed: 556 ~
% Lines Processed: 94%

Blank Lines Processed: 124

% Blank Lines Processed: 22%

Comment Lines Processed: 88

% Comment Lines Processed: 15%

Unsupported Lines Processed: 66

% Unsupported Lines Commented: 11%

UnProcessed Lines: 30

% UnProcessed Lines: 5%

------------ UnProcessed Keywords List -

5 THISFORMSET .frmFD.DrawColor |

2 frmFormMName. line[rCenter,0,nXCenter frmFormM ame. height)

2 THISFORcboFromYear. SetFocus

2 frmFormMName. line(0,nYCenter,frmFormMN ame. width,nYCenter)

1 THISFORcboToYear. SetFocus

1 oFmD ate. Show

1 THISFORMSET.frmFD.SetCaption

1 THISFORMSET.frmFD.ClearForm

1 THISFORMSET.frmFD.ChgDrawhMode

1 frmFormM ame. pset(nXCenter+[re{T emp*nE quScale),.nYCenter-y) v

The automated conversion processing done by the Visual FoxPro Code Converter will attempt to make
as many changes as is practical to convert FoxPro code into compatible Servoy JavaScript code. There
are however a variety of changes which can only be performed manually.

Code restructuring - A FoxPro PRG file can contain bare keywords outside of a Function/Procedure
because the whole file is basically treated like a procedure. Servoy developers generally write all code
encapsulated within a method (or function). Also, most Servoy methods don't define additional
methods, so these will generally need to be restructured to become separate methods.

Windows Client Based Coding - Commands which attempt to write directly to a DBF file on a user's
local disk or open/close database files are unsupported, and unneeded within a Servoy application. All
database connections are available immediately just by specifying the dataProvider. And all tables are
stored centrally instead of on the user's local hard disk.

Visual FoxPro Specific Coding - The SET, SYS() and FORMSET commands are very specific to
functionality which only exists within FoxPro - therefore these commands are commented out and
marked as unsupported. FoxPro specific functions also come into this category, though some
commonly used functions are converted during the preParsing part of the conversion process.

Form Object Creation Coding - Servoy forms are built by the developer (or converted by FmPro
Migrator directly from the original FoxPro forms/reports/labels). Generally, Servoy objects are not
created on forms programmatically by the developer, so the FoxPro ADD OBJECT commands are
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commented out as unsupported.

Command Line Coding - FoxPro projects may contain commands which prompt a user to enter an
answer in a command window and wait for the user to enter an the answer. Processing continues once
the user has entered the answer followed by a return key. Servoy apps are event driven apps designed
with a graphical interface instead of being command line driven apps. In a Servoy app, the user enters
info into fields on a form and then clicks in the form background to commit the record or clicks a button
to initiate the processing. Therefore the processing of the entered info could be done via a calculated
field or by the button click event.

KeyBoard Event Driven Coding - FoxPro code may contain keystroke driven event code. A Servoy
application cannot be dependent upon trapping a particular keystroke combination in order to trigger
the execution of code because the application may be deployed via a web browser.

List of Supported Keywords

There are 60 keywords supported during the code conversion process. These keywords are:

*

&&

+

ACTI WIND
ACTIVATE WINDOW
ALLTRIM()

AND

CASE

CASE RETURN
CHR()

CHR()

COUNT

CREATE TABLE
DIMENSION
DISPLAY DATABASE
DISPLAY TABLES
DO

DO CASE

DO FORM

DO WHILE

ELSE

ENDCASE
ENDDEFINE
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ENDDO
ENDFOR
ENDFUNC
ENDIF

ENDIF
ENDPROC

F.

FOR

FOUND()
FUNCTION

IF

INSERT INTO
INT()

LEN()

LOCAL

LOOP
LOWER()
LTRIM()
MESSAGEBOX
MODIFY DATABASE
NOT

OR
OTHERWISE
PRIVATE
PROCEDURE
PUBLIC

QUIT
RETURN
RTRIM()
SHOW WINDOW
SORT

STORE
SUBSTR()

T.

UPPER()
VAL()

WAIT
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List of UnSupported Keywords

There are 55 keywords which are unsupported during the code conversion process. These keywords
are:

$

?

ADD OBJECT
APPEND

BOF()

BROWSE

CLEAR ALL

CLEAR EVENTS
CLOSE ALL
CLOSE DATA
CLOSE DATABASE
CLOSE TABLES
CONTINUE
CREATE

CREATE DATABASE
CTOD()
DEACTIVATE WINDOW
#DEFINE

DEFINE WINDOW
DELETE
DELETED()
DISPLAY

DISPLAY

DTOC()

EOF()

GO

GOTO

HIDE WINDOW
#INCLUDE

INDEX

LIST

LOCATE

MODIFY STRUCTURE
ON ERROR

ON KEY

OPEN DATABASE
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PACK
POP KEY

PUSH KEY

READ

RECALL

RECNO()

RELEASE

RELEASE ALL

RELEASE CLASSLIB
RELEASE THISFORMSET
RELEASE WINDOW
REPLACE

SELECT

SET

SKIP

SUM

THISFORMSET

USE

ZAP
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Servoy Conversion
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Create Servoy Eclipse Project

Create New Servoy Eclipse Project

m Edit Navigate Search Project Elements Actions Wil

= Project...

Open File...
i Other...

Close #BW
Close All O ¥W
Save abS = O
| Save As... — ‘@é o & v
Save All {3S —
Revert ﬂ
Move...
Rename... F2
Refresh FS .
Convert Line Delimiters To [+ s
Print... ab P =
Switch Workspace I
exg Import...
ey Export...
Properties AW

Select New -> Project from the File menu to create a new Servoy Eclipse 4/5 project.

This step is necessary, because FmPro Migrator will delete and re-create the directory when creating
the new Servoy Eclipse project from the FileMaker Pro database structure information stored within the
FmPro Migrator MigrationProcess.dba3 file.
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Enter project name

® e New solution

Create a new solution

- a new Servoy solution project will be created B
Solution name @

Solution type | Normal B

Please choose the resources project this solution will reference (for styles, column/

() Create new resource project  resources

(®) Use existing resource project  resources

@ C < Back ) Next > ) C Cancel )
Vi

Enter the project name, then click the Finish button.
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Enter Servoy Project Parameters

Click FmPro to Servoy Migration Service Button

ﬁ: Migration Process

Tables | Relationships | TOs | Valuelists | CFs | Layouts | Scripts | GUI

| :

Instructions:

Convert Layouts
to HTML: |

Click the Convert L) |
Layouts to HTML
hutton to convert

each FileMaker Pro Convert Layouts Export Layouts

layout into an HTML to HTML as XML

file. Each file

includes fields, text

labels, images, Services

graphic ohjects and i

JavaScript code for 3 @
implementing

portals and pop-up ‘ =
calendar pickers. e SRS o
Export Layout XML: Af:cest to Fmero FI_IIPIO' to Accgss _ S'elvoy '
Click the Export Migration Service Migration Service Migration Service

Layouts as XML
hutton to export the
layout definition XML

for all layouts as text | (\ | W
files. Each layoutis @/ yo 1
exported as atextiile | 4\ /

within a folder i 4

named LiveCode ’PHP toLiveCode ‘ Visual FoxPro
Layout_XML_Files Conversion Conversion Conversion Service
within the output

directory.

Access to FmPro

1) Click on the GUI folder tab within the FmPro Migrator Migration Process window.
2) Click on the Servoy Migration Service button.
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Servoy Project Parameter Fields - Demo Mode

P Servoy Migration Service

Instructions: 3 = = —
Migrate FileMaker = | - THE
Pro Databases to - .. ol i

Servoy: == ’ —

Step 1) Import

information about Layout Qty: a7

the FileMaker Pro

database(s) into Project Name: vfp1_solution

FmPro Migrator

Deve|0per Edition DB Connection: lTl_','SQl_me1 7 e
following the Tahle Project Directory: C:/Documents and Browse
Consolidation I 2 ——— :
Procedure PDF. Processing Type: Demo v [ Order License Key J

Step 2) Create a new

Servoy Eclipse 4.1+

project. Enter the

nhew Project Name,

Datahase QUOTE
Connection name

and selectthe new

project workspace

directary. . [ Migrate ]

By default, FmPro Migrator sets the Processing Type for the FmPro to Servoy Migration Service to
Demo mode. When running in Demo mode, 5 layouts and 5 scripts are processed - and all other
objects including relationships, globals and value lists are migrated.

(1) Enter the Servoy project name which was just created, (2) the Servoy database connection name,
(3) and select the project directory within the Servoy project workspace.

Note: Since FmPro Migrator deletes and re-creates the project directory each time the Migrate button is
pressed, there are a couple of safety features incorporated into the Project Directory Browse button.
The selected output directory path must contain the text "workspace" and it must contain the text
consisting of the Project Name ("t2" in this example).
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To enter the Servoy Migration license key, select "Licensed” from the Processing Type menu, copy the
license key to the clipboard from your email program, click on the clipboard icon to the left of the license
key field. The license key will be copied from the clipboard and validated.
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Servoy Migration - Migrate Button

Click Migrate Button

23? Servoy Migration Service

Migrate FileMaker

]
Pro Databases to
Servoy:
Step 1) Import

information ahout
the FileMaker Pro
database(s) into
FmPro Migrator
Developer Edition
following the Tahle
Consolidation
Procedure PDF.

mysql_mbp17

C:/Documents and

Step 2) Create a new
Semvoy Eclipse 4.1+
project. Enter the
new Project Name,
Database
Connection name
and select the new
project workspace
directory.

1

Clicking the Migrate button starts the conversion process for the Layouts, Value Lists and Scripts stored
within FmPro Migrator. The selected Servoy project is deleted and completely re-created during the
migration process.
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Servoy Migration - Refresh Project

Refresh Servoy Project

) solution Explorer 2

>  Filter

ar

Forms
@ bldtree
® calc
@
® chkmenu
clock
J crndbtn
J cmdtop
commdlog
controls
createsql
customer
J datalook
J dbctofrx

=l

R S R = S = O o A R S e 2 8

<

>

Click the Refresh View button in the Servoy Eclipse IDE after generating the new project. The Servoy
Eclipse IDE may prompt you to update the project to the latest file format version.

Note: Currently, Servoy projects created by FmPro Migrator are created using the Servoy 4.1 file
format. New versions of the Servoy Eclipse IDE will automatically upgrade the file format to version 5.
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Open & View Converted Forms

(o Servoy Design - vfp1_solution.calc - Servoy Developer

File Edit Mavigate Search Project Elements Actions Run Window Help

] i E-iAFa8¢R U_E NoRuNaNMEY L B NI A R TR
SRR BES%EHD %o off Off 17 o o ote oo 500 F 31§
6 Solution Explorer &2 =0 cale 22 checkbox =08
~ ] ! 100 [ 200 ! 300 ! 400 [ 500 ! €10

i A . A

@;9 }:{ V:; _ Click a column header to see the ControlSource property for the values in the column. Gray fields have a caleulated C...
rect
=] % Forms »~
bldtree fipducts -

o
I
¢l 2] open in script editor Ctrl+Shift+2
cr

o (D Create method

¢ Create new sub form

c
o Toggle Form Commands

cu

e e e E
8 1

Team »
jl Compare With »
Replace With > . . . . . . |

B¢ Move form
o Duplicate form
=] foundset ¥ Delete form
@ almethods
|5 Copr Ctrl+C

|€

uence  Security

Right click on any form and select the Open in form designer menu item to view the converted form in
the Servoy Eclipse IDE.

Visual FoxPro to Servoy Conversion Procedure - 65



Post Migration Tasks - Visual FoxPro to Servoy Migration

Some manual steps will be required after the automated processing has been completed.

Unsupported Form/Report Features

There are some elements incorporated within Visual FoxPro Forms/Reports which are not currently
supported Servoy Migration Service. These elements include report parts (Header/Footer, Sub
summary sections) and ActiveX controls embedded on forms.

Layout Parts - The Layout XML format does not include information about layout parts, so this
information cannot be processed automatically. However FmPro Migrator does automatically create a
body part for each Servoy Form which is created, in order to insure that you can immediately see the
objects within each form. It is easy to add/remove/change form parts within the Servoy Eclipse IDE.

Object Tab Order - The Layout XML format does not include information defining the tab order of each
object on the layout, so this information cannot be passed thru from the original project file.

Object Z-order Stacking - The Layout XML format does not include information about the front to back
stacking order of the objects on the layout, so this information cannot be passed thru from the original
project file. However FmPro Migrator does assign a formindex parameter for each form object in order
to reduce the possibility of important objects like fields and text labels from getting covered up by
objects like rectangles and images. Some manual changes may still be required after the automated
conversion.

ActiveX Controls - It does not currently appear to be possible to read enough information about
individual ActiveX controls on Visual FoxPro forms to determine what type of control or parameters are
being implemented. Therefore FmPro Migrator simply creates a red box representing the object on the
form. This way, FoxPro developers can quickly determine if there were any ActiveX controls on the
converted form.

Many commonly used ActiveX controls have equivalent Java bean implementations which are either
included or can be added to a Servoy Eclipse project. Some of these Java beans include beans which
implement a TreeView or charting. Select the Place Bean... button from the toolbar at the top of the
screen to display a list of installed Java beans. [See screenshot above.]

There are 3rd party Java beans available from the Servoy Marketplace. as well as the
servoycomponents.com website. Some of the Java beans and plug-ins included on the
servoycomponents.com website include: Calendar Bean, Gantt Bean, Barcode and plug-in Bean, DDE
Plug-in, HTMLeditor Plug-in, Cryptor Plug-in, Dialog Plug-in and FAX Plug-in.
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http://www.servoy.com/marketplace
http://servoycomponents.com

Visual FoxPro Code to JavaScript Conversion

Every Visual FoxPro script is converted into lines of commented Javascript code, which is written into
the Globals.txt file within the Servoy project directory. There is an easier to read uncommented version
of the original scripts stored in the VFP_Scripts.txt plain text file within the FmPro Migrator Output
Directory. This code is provided as a guide to the Servoy developer during the development of
replacement Javascript code to replace the original business logic. It is important to note that a
significant amount of Visual FoxPro code which was used for managing record locking and multi-user
DBF file access will no longer be needed in the converted solution because the Servoy application
server handles these tasks automatically.

Custom and Dynamic Value Lists

™ (=]

(© solution Explocer £3

)

Fiker ©~ V& X =
» BB Layouts ~
Ei= Relations
1] valuelsts m
Media
s Modules
» BB s 2

c—

o
N

1] Category_List
3] Checkbox_ 1.0

FmPro Migrator converts custom value lists into Servoy Value lists. However some custom value list
names may have been duplicated within the original FileMaker solution if it was a multi-file solution.
Duplicated Value Lists having the same name and contents will be skipped automatically by FmPro
Migrator. Duplicated value lists having the same name but different contents will be renamed and
added to the Duplicate Objects Report.xls file generated by FmPro Migrator. Manual work will be
required if a renamed Value List contains information which is actually preferred over the first
occurrence of the Value list which was created.

Dynamic value lists will require manual work to add them to Servoy and then associate the value list
with the appropriate field objects.
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